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Virtual Chromatography Laboratory 

Part 1: Gas Chromatography 

 

In this exercise, you will be using ACD/Labs GC Simulator 9.0 to explore gas 

chromatographic behaviour.  The software makes use of various known 

relationships between gas chromatographic retention times and molecular 

properties, including boiling point/vapour pressure and octanol-water partition 

coefficients (log Pow, a measure of the hydophobicity of the molecule).  The 

software can predict boiling points and, therefore, the retention behaviour of 

molecules based on their chemical structure; these can be imported from 

ChemSketch directly into the GC Simulator module.  Alternatively, experimental 

data can be imported and used to generate prediction equations; these can in turn 

be used to optimise the separation and determine if additional sample components 

could be resolved under such conditions. 

 

There are various questions throughout this exercise that you should answer and 

submit at the end of the exercise.  The exercise is broken down into a number of 

separate exercises; these should be completed in order.  Please keep track of the 

total time spent on this exercise, and report that together with your answers to the 

questions.  Any additional comments or suggestions on this exercise are also 

welcome. 

 

Short glossary: 

 

Retention time, tR: 

 Elapsed time from injection to detection of the peak centre for a 

retained compound 

 

Dead time or void volume, t0 or tM: 

 Time from injection to detection of the peak centre for a completely 

unretained compound; also the time for one mobile phase volume 

(VM) to pass completely through the column, i.e. t0 = VM/F 

 

Capacity factor, k’: 

 Retention time expressed relative to dead time, i.e. (tR – t0)/t0 

 

Resolution, Rs: 

 Defined as the separation divided by the average baseline width for 

two adjacent peaks, i.e. Rs = 2(tR2 – tR1)/(w2 + w1) 
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Exercise 1: Exploring a Stored Chromatogram 

 

1.1 Login to the computer as 

 

  User:  _____________ 

  Password:  __________ 

 

1.2. Go to Start !  Programs !  ACDLabs 9.0 (NETWORK) !  GC Simulator 

 

1.3. Open the file 
 C:\Documents and Settings\chm416\My Documents\virtual1.gc5 

 

Important:   

Please do not save any changes you make back to the original file.  Should 

you need to interrupt your work, save the modified file using a unique name. 

 

You will notice that the file opens with various graphical panels across the 

main window, as well as a menu bar, tool bar, and various status displays 

and buttons along the bottom.  
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1.4 Move the cursor across either the chromatogram (lower panel) or peak table 

(upper panel).  As you do so, the information on the left-hand side of the 

window will also change.  The term ‘Pre Rs/Post Rs! refers to the resolution 

between the current peak (in this case #5, butyric acid) and the peaks 

immediately before (#4) and after (#6).  The three buttons in the tool bar 

( , , and ) allow you to switch the labelling used in the 

chromatographic display.  The button with the benzene ring ( ) turns the 

structure display on or off; you can also use the Structure ! Show item in 

the View menu.  The Structure submenu also lets you chose whether the 

structure is displayed in a floating or popup window.  The floating window 

should default to within the chromatogram panel; the popup window can be 

dragged and resized to any convenient area of the screen. 

 

You can obtain further chromatographic details by clicking on the Data Input 

button on the lower left-hand side of the main GC Simulator window.  Doing 

this opens a dialog box (below) featuring two tabbed displays, GC 

Parameters and Chromatogram.  Click on the GC Parameters tab to view 

the experimental conditions used to obtain the actual chromatogram 

displayed.  When you are done, simply click on either the OK or Cancel 

buttons to dismiss the dialog. 

 

 
 

Q1 Was the chromatogram obtained under gradient or isothermal 

conditions?  What was (were) the temperature(s) and flow rate used? 
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1.5 Obtaining a hard-copy of the chromatogram:  you will notice that one of the 

tool bar buttons has an icon that looks like a printed page ( ); clicking on 

this button generates a report within the ChemSketch program.  You can also 

choose the Copy to Report Editor… item in the Edit menu.  Make sure that 

Chromatogram is checked in the View tab of the Report Page Setup dialog 

box.  You can also add your name etc. in the Text tab.  Click OK when you 

are satisfied with the selected options. You can print out the chromatogram 

and peak table once the report has opened in ChemSketch.  

 

  
 

 If you select the Table of Peaks option, the chromatogram and peak table 

can end up on different pages.  There is a very small page control in the main 

window.  Make sure you print all pages if you also selected the peak table 

option. To return to the GC Simulator, select Optimizations from the taskbar 

at the bottom of the ChemSketch window and dismiss any error message.  

You may now exit the program(s) and logout from the computer workstation 

if you need to. 

 

1.6 Answer the following questions regarding the specimen chromatogram: 

 

Q2 Look at the structures of the organic acids separated in this 

chromatogram. 

 

(i) What determines the elution order of linear (straight-chain) acids?  

Explain your answer. 

 

(ii) What determines the elution order of structural isomers (i.e. linear 

versus branched with the same number of carbon atoms)?  Explain 

your answer. 
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Q3 Based on your observations in question 2, estimate the retention time 

that you would expect to observe under identical chromatographic 

conditions for (a) hexanoic acid, CH3(CH2)4CO2H and (b) pivalic acid, 

(CH3)3CCO2H (2,2-dimethylpentanoic acid).  Show your calculations. 
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Exercise 2: Checking Predictions 

 

2.1 Open the same stored chromatogram used in exercise 1 (virtual1.gc5), and 

click on the ChemSk button in the bottom-left corner of the main window to 

transfer to ChemSketch.  Once in ChemSketch, open the file 

fattyacids.sk2.  This file contains structures for the two acids whose 

retention times you were asked to estimate in the previous exercise. 
 

2.2 Still in ChemSketch, click on the Optimizations button at the bottom of the 

window.  This will transfer both structures to the GC Simulator module, 

which will use the existing data to predict the retention times for these new 

compounds. 

 

 
 

 

 You will notice that there are two new entries in the peak table: ‘structure_1’ 

and ‘structure_2’.  Move the cursor over the table entries to determine which 

peak matches which entry.  You can enter the correct names by clicking on 

the Data Input button.  Click on the appropriate cell in the spreadsheet-like 

area of the Chromatogram tab, and enter the name in the editable field in the 

top-left corner of the tab panel.  Once you are done, click on the OK button 

to return to the main window, and obtain a hard copy of the report (see step 

1.5 above). 
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2.3 The report should list the retention times predicted by the software for all 

peaks, not just the structures you added.  Compare the values of tR(exp) with 

tR(calc).  You will notice that the errors in predicted retention time are 

typically about 5% or less. 

 

Now open the file virtual2.gc5.  This shows a specimen chromatogram 

of a mixed fatty acid standard obtained using capillary GC with a 

temperature gradient.  Obtain a copy of the report for this chromatogram 

also, and answer the following questions: 

 

Q4 How well did the predictions (yours and the computer’s) compare to 

the actual elution order of the fatty acids?  If there was a significant 

difference (i.e. more than 5%) what might explain this? 

 

 You may now exit the program(s) and logout from the computer workstation 

if you need to. 

 

2.4 Answer the following questions relating to the chromatograms used in parts 

1 and 2: 

 

Q5 How much longer would the packed column from the first 

chromatogram have to be in order for butyric acid and isobutyric acid 

(2-methylpropionic acid) to be resolved with Rs = 1.50?  (The original 

column was 1.83 m long.) 

 

Q6 In the light of the two different chromatograms obtained for the 

volatile fatty acids, what would you consider to be the primary 

advantage(s) of a capillary over a packed column? 

 

Q7 When is it potentially a disadvantage to use a capillary rather than a 

packed column? 
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Exercise 3: Optimising a Temperature Gradient 

 

In this final exercise with the GC Simulator, you will explore the effects of 

temperature programming on a specimen chromatogram.  In this particular case, 

two experimental separations of the same compounds on the same column have 

been obtained at different temperatures and pre-loaded into a prediction file.  The 

software uses this information together with the properties of the sample 

components to predict the effect of column temperature on resolution and run time. 

 

3.1 Launch the ACD/Labs GC Simulator (or switch to the GC Simulator module 

if you still have the ACD/Labs suite open) and load the file: 

 
 C:\Documents and Settings\chm416\My Documents\virtual3.gc5 

  

Important: 

As with the other sample files in this exercise, please do not make any 

changes to the actual file.  If you need to save your work to resume later, 

please use save the file using a different name. 

 

 You will notice that the main window contains an additional panel and some 

extra buttons. 
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 The spreadsheet-like area at the top-left allows you to change the 

temperature program, which is also displayed graphically above the 

chromatogram.  You can switch between the gradient editor display and the 

peak table using the buttons directly above this upper panel.  Before you 

continue, obtain a hardcopy of the chromatogram by using the Copy to 

Report Editor…  toolbar button or menu item as in previous exercises.  Once 

you have printed out the report, switch back to the GC Simulator module by 

clicking on the Optimizations button at the bottom of the ChemSketch 

window. 

 

3.2 Drag the mouse across the chromatogram, and note which peaks have the 

lowest resolution between them (this will be displayed for each peak as 

PreRs/PostRs values in the area on the left of the screen above the Data Input 

button).  Also note the run time (retention time for the last peak in the 

chromatogram).  Finally, note the times at which the different points of the 

temperature gradient occur, and compare this to the run time. 

 

Change the final (third) point in the temperature gradient to 85 °C at 30 min; 

this corresponds to the column temperature obtained just after the last peak 

elutes from the column.  You can do this either by editing the entries in the 

spreadsheet area, or by clicking and dragging the point in the gradient editor 

window.  Note that two of the buttons directly above the gradient editor 

allow you to constrain the direction of dragging to either horizontal or 

vertical ( ), while the button immediately to the left of them restores 

simultaneous horizontal and vertical motion ( ). 

 

3.3 Adjusting the initial hold: the hold time is the duration of the initial 

isothermal segment of the temperature program.  It allows the solvent to be 

separated from the sample components at the head of the column, so that the 

full column length is available for separating individual sample components. 

 

Q7 What would be the effect of increasing the hold duration on the 

retention time and resolution of the first four peaks? 

 

Q8 What would be the effect of decreasing the hold duration on the 

retention time and resolution of the first four peaks? 

 

3.4 After recording your prediction to questions 7 and 8, click on the button to 

constrain dragging to the horizontal direction ( ), and try increasing and 
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decreasing this value.  Note that, as you increase the initial hold time, the 

temperature ramp will have a correspondingly steeper slope. 

 

Q8 Is it possible to reduce the retention time for the first peak by 

changing the duration of the initial hold?  If so, by how much can you 

change it, and what is the shortest attainable retention time?   

 

Q9 What affect would increasing the temperature of the initial isothermal 

hold have on the chromatogram? 

 

3.5 Find out whether or not you were correct in your answer to the last part of 

question 9 by changing the temperature of the initial hold.  Note: you must 

change the temperatures of both the first and second points in the 

temperature gradient to the same value.  You can do this by setting the drag 

mode to vertical (temperature axis) and raising or lowering both points, or 

by editing the gradient table directly.  Determine the initial hold conditions 

(temperature and duration) that give you the shortest possible retention time 

for the first peak whilst keeping it resolved from the second peak (i.e. Rs " 

1.5).  When you are satisfied with your changes, print a copy of the results 

and return to the GC simulator module as you did in step 3.1. 

 

Q10 What ultimately limits the shortest retention time that can be attained 

for the first peak, assuming the same column and flow rate are used?  

 

3.6 Adjusting the temperature gradient:  the temperature gradient is defined by 

the heating rate (i.e. slope of the temperature-time plot) and final 

temperature (i.e. duration of change).  It is usual to have a final hold, in 

which the final temperature attained by the program is maintained 

isothermally until the chromatographic run is completed. 

 

Try adjusting the time and temperature for the third point in the temperature 

program so that the overall run time is reduced while retaining full baseline 

resolution between all peaks.  For practical purposes, assume that the 

maximum column temperature is limited to 250 °C.  You may also vary the 

initial hold parameters if necessary.  When you are satisfied that you have 

obtained the shortest run time whilst maintaining resolution, print a final 

report. 
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3.7 Click on the ChemSK (Chem Sketch) button in the lower-left of the 

window, and open the file aromatics.sk2 (in the same directory as the 

previous file).  This contains the structures of the following compounds, 

some of which are already in the sample chromatogram: 

 

Compound Tb (°C) Mm (g/mol) 

benzene 80.1 78.12 

toluene 110.6 92.15 

ethylbenzene 136.2 106.17 

o-xylene 144.4 106.17 

p-xylene 138.3 106.17 

n-propylbenzene 159.2 120.20 

 

Q11 Considering the structure, size and boiling points of these compounds, 

predict roughly where you would expect benzene, toluene, and n-

propylbenzene to elute relative to the rest of the peaks in the 

chromatogram under the conditions derived in the preceding step. 

 

3.8 Select the structures of benzene, toluene, and n-propylbenzene in the 

ChemSketch file by holding down the shift key down whilst clicking below 

each one.  Transfer these to the GC Simulator by clicking on the Predict for 

Gradient button. Print any final chromatogram, and exit the ACD/Labs 

Method Development Suite. 

 

Q12 Are all the peaks resolved?  If not, adjust the temperature gradient so 

that they are.  How well did your prediction match up with the 

computer prediction? 

 

Q13 Given the results obtained in this exercise, what aspects of molecular 

structure contribute to elution order in GC?  What role, if any, do 

features such as aromatic rings and ring substitution play?  (Compare 

your findings in part 3 with those from parts 1 and 2.) 
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Virtual Chromatography Laboratory 

Part 2: Liquid Chromatography 

 

In this exercise, you will use the ACD/Labs LC Simulator 9.0 module to examine 

the effects of solvent composition on elution in liqquid chromatography.  In this 

particular case, you will make use of chromatograms that have already been 

combined and prepared for use in the LC Simulator module.  As was the case for 

the GC Simulator, this module makes use of a variety of experimental databases 

and physical parameters (both measured and calculated) in order to predict 

retention behaviour in HPLC.  Since we are now dealing with a liquid mobile 

phase, one important difference between the LC and GC modules is the use of log 

D as a parameter; this is the same as log Pow, but is pH-dependent.  This reflects the 

importance of pH on elution in HPLC, especially given the number of acidic and 

basic compounds analysed by this technique. 

 

There are various questions throughout this exercise that you should answer and 

submit at the end of the exercise.  The exercise is broken down into a number of 

separate exercises; these should be completed in order.  Please keep track of the 

total time spent on this exercise, and report that together with your answers to the 

questions.  Any additional comments or suggestions on this exercise are also 

welcome. 

 

Exercise 1: Exploring the Effect of pH 

 

1.1 Login to the computer as 

 

  User:  _____________ 

 Password:  __________ 

 

1.2. Go to Start !  Programs !  ACDLabs 9.0 (NETWORK) !  LC Simulator 

 

1.3 Open the file 
C:\Documents and Settings\chm416\My Documents\drugs.lc7 

 

 You will see an alert box warning you that some data need to be recalculated 

– click OK, and you will find the following dialog box displayed on the 

screen: 
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This is the same dialog you see whenever you click on the Data Input button in the 

main simulator window.  As you can see, it lists the names of a series of 

compounds, together with relevant parameters such as retention time, peak width, 

and area.  Click on the Predict button – the software will then calculate values of 

log P or log D, and predict retention times for each peak based on these 

parameters.  Finally, click on the OK button to close the dialog box and see the 

actual chromatogram. 

 

Important: 

 Please do not save any changes you make back to the original file.  Save the 

modified file using a unique name. 

 

1.4 Navigating through the LC Simulator Module:  you will notice that the 

layout of this module is similar to the GC one, and many of the tools work in 

the same way.  You will also notice some significant differences between the 

LC and GC modules.  You will notice in the screen-capture below, for 

example, that the window shows something called a “resolution map” panel 

with pH as a parameter.  The resolution map uses the prediction equation 

generated from experimental data, and the structures of the compounds in 

the chromatogram, to predict the effect of pH on the resolution between the 
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“critical pair” – the two peaks with the lowest resolution of any pair in the 

chromatogram for the specified parameter value.   

 

 
 

 You will also notice that some additional data is provided on the left-hand 

side of the main window, just below the editable text field indicating the 

current pH value for the mobile phase.  As with the GC simulator, you can 

have the software display the compound structures in a panel or floating 

window by either  clicking on the structure button in the toolbar or selecting 

the appropriate options in the View !  Structure Window sub-menu.  The 

same set of peak-labelling options are also there, with the addition of a “log 

D” button – this displays the calculated log D value for each peak. 

 

1.5 Click on the Data Input button on the lower left-hand side of the main LC 

Simulator window.  This will allow you to check the details of both the 

sample components and elution conditions through the HPLC Parameters and 

Chromatogram tabs.  Click on the Mobile Phases button in the HPLC 

Parameters tab to see a table of the mobile phase components and buffer 

composition.  Note that the “water” refers to an aqueous buffer, whose 

composition is listed to the side. 

 

 



 Page 15 

    
 

 

1.6 Answer the following questions regarding the specimen chromatogram: 

 

Q1 Was the chromatogram obtained under gradient or isocratic conditions? 

 

Q2  What was the mobile phase used in the experiment? 

 

Q3 What type of HPLC is being performed – normal or reverse phase?  Give 

the reason for your answer. 

 

 Close both dialog boxes to return to the main LC Simulator window. 

 

1.7 You can vary the pH conditions in two ways: 

 

(a) Manually, by entering values into the editable text box in the upper-left 

corner of the window and pressing the enter key. 

 

(b) Graphically, by clicking and dragging the blue diamond in the resolution 

map display.  (Note: the blue bar shows the original pH setting.)  This 

works in the same way as the temperature gradient in the GC simulator 

module. 
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 Using either method, examine the effect of changing the pH from 4 to 12 in 

steps of 1 pH unit, paying particular attention to retention time and elution 

order within the chromatogram. 

 

Q4 Peaks 2 and 5 show hardly any variation in tR over this pH range, whereas 

the other peaks move considerably.  Why is this? (Hint: review the 

structures of the individual compounds; you can do this either by turning 

on the structure display feature, or by clicking on the different entries 

within the Chromatogram tab of the Data Input dialog box.) 

 

Q5 What is the consequence of this difference in pH-dependence of the 

sample components on the overall elution order?  What general principles 

can be inferred from this for optimizing the separation of acidic and/or 

basic compounds in HPLC? 

 

Q6 What pH would you have to use in order to reduce the run-time below 7 

minutes? 

 

Q7 In practice, silica-based columns cannot be exposed to such high pH 

values.  Suggest two practical alternatives that could be used to reduce the 

run-time. 
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Exercise 2: The Effect of Mobile Phase Composition 

 

2.1 From within the LC Simulator module, open the file 

 
C:\Documents and Settings\chm416\My Documents\KOD_GR.lc7 

 

Important: 

 Please do not save any changes you make back to the original file.  Should 

you need to interrupt your work, save the modified file using a unique name. 

 

 Note that the software may ask if you want to switch to gradient mode when 

you do this; answer “yes”.  The main LC Simulator window should now look 

like this: 

 

 
 

 Note that the display can be set to show either or both the resolution map 

and the solvent gradient.  You can change the display mode using the 

appropriate buttons just above the display area (Table of Peaks, Resolution 

Map, Gradient Editor, and Resolution Map/Gradient Editor).  Study the 

information provided in both the main window and the HPLC Parameters 

and Combined tabs of the Gradient dialog box opened by clicking on the 

Data Input button, then answer the following questions: 
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Q8 What are the two solvents used in the mobile phase?  What are the 

initial and final compositions of the mobile phase, expressed as 

volume% of each component, in the two experimental chromatograms 

used to generate the prediction data?  (These can be found on the 1st 

and 2nd tabs of the Gradient dialog box.) 

 

Q9 Is this a normal or reverse phase separation?  Give the reason for your 

answer. 

 

Q10 Pick one peak from the combined chromatogram, and predict on the 

basis of the compound structure and the solvent mixture whether 

decreasing the initial amount of solvent B to 50% will increase or 

decrease it’s retention time.  Explain your answer. 

 

Q11 Use the k' value of the peak you chose to calculate the effect of 

making such a change using the polarity index P' and assuming 

isocratic conditions (see Skoog or the lecture notes for details.)  Show 

your calculation, and clearly state any additional assumptions you 

made.  Note: the k' value is included in the peak information on the 

left-side of the window. 

 

2.2 The gradient can be edited in the same way as the temperature gradient in 

the GC module; you can edit the values directly in the spreadsheet area in 

the upper left-hand corner, or you can click and drag the points in the 

graphical panel on the right.  (You can also drag the blue diamond on the 

resolution map, which will change the time for the second gradient point.)  

Modify the gradient so that the initial amount of solvent B is 50%. 

 

Q12 Compare your initial prediction, your calculation, and the software 

prediction of the new retention time for your chosen peak.  Given that 

polarity index calculations are, by nature, estimates rather exact 

calculations, under what conditions can they be used to estimate the 

effect of changes in  solvent composition on retention under gradient 

conditions?  

 

2.3 Examine the effect of changing the solvent gradient from an initial value of 

0% B to isocratic elution (i.e. 100% B from 0 to 11 min). 

 

Q13 Summarise the effect of changing the solvent gradient on (a) the 

overall run-time, and (b) the resolution of the sample components. 
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2.4 Set the gradient to run from 50% to 100% B, starting at 0 and ending at 11 

min.  Make sure that the resolution map is displayed (click on the 

Resolution Map button.)  You will notice that there are two regions with a 

white background and a green bar underneath, indicating two possible sets 

of conditions within which good separation may be obtained.  Drag the blue 

diamond within the resolution map panel to vary the steepness of the 

gradient (this simply changes the time at which 100% B will be reached). 

 

Q14 What happens to the run-time in comparing these different regions? 

 

Q15 What happens to the elution order as you vary the steepness of the 

solvent gradient?  What is affecting this order? 

 

Q16 Is it possible to obtain an isocratic condition that will provide the 

same or better run-time whilst maintaining full resolution of all peaks?  

Which would be better from a practical stand-point: isocratic or 

gradient elution? 
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Virtual Lab. Survey: 

 

Please take the time to answer the following questions, and attach them to your 

report for this virtual laboratory exercise.  Thanks!! 

 

S1 Did you find the GC and LC exercises helpful? 

 

(not at all)  1  2  3  4  5  6  7  (extremely) 

 

S2 Were the instructions provided clear and easy to follow? 

 

(not at all)  1  2  3  4  5  6  7  (extremely) 

 

S3 Have you done much practical chromatography prior to taking this course? 

  

Yes    No 

 

If yes, how many chromatograms do you estimate you have run? _____ 

 

S4 Do you think these exercises helped you better understand elution  

 

 (i)  in GC? 

 (not at all)  1  2  3  4  5  6  7  (extremely) 

 

 (ii)  in HPLC? 

 (not at all)  1  2  3  4  5  6  7  (extremely) 

 

S5 Are there any specific aspects of chromatography that you would like to see 

included in these exercises? 

 

 

 

 

 

S6 Are there any suggestions you have for improving these exercises? 

 

 


